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1 

 

 

 This guide describes a simple software which is comprised of the halometer and 

permits the execution of a test to detect as well as quantify certain disturbances of night 

vision, such as halos perceived by an observer. The halometer software is called Halo v1.0, 

created and developed by the Laboratory of Vision Sciences and Applications of the 

University of Granada (Spain). Its installation in a computer and the use of a previously 

calibrated monitor allows the execution of the test.  

 

              
                                           a)                                                          b) 

 

Figure 1.1. Simulation of: a) a light source in the absence of a halo; b) halo 

around an intense light source perceptible to an observer. 

 

 

In broad terms, halos in vision occur when an observer perceives circles of light 

around light sources, particularly focal points of light and especially at night (Fig. 1.2), 

resulting in a loss of visual quality and therefore of visual discrimination.  

 

The alteration of night vision, including glare, starbursts, and haloes, are frequent 

after refractive or cataract surgery, although these alterations can also occur naturally. In fact, 

the most usual complaint of post-operational subjects is the presence of haloes.  

 

1.  I N T R O D U C T I O N .  
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Figure 1.2. Two photographs made of a night scene: the one on the left under normal conditions; 

the one on the right depicting haloes around the light sources. The presence of haloes 

considerably diminishes the discrimination capacity of stimuli under high luminance.  

 

 

 The recent development of ocular surgery has lent to special relevance to disturbances 

affecting night vision. Under low illumination, the pupils dilate, whereupon the image of an 

object disperses and a certain defocusing appears due to the spherical aberration of light 

scattering through the ocular media. This effect is accentuated when these media have been 

surgically treated, altering the transparency of the tissue where, furthermore, changes have 

occurred in the refracting power of the cornea, resulting in a certain sensation halo perception 

by the subject. 

 

For example, the cornea of a patient undergoing refractive surgery is normally 

operated on within an optical zone of some 5 or 6 mm and a small additional transition zone 

of 1 to 2 mm. Under low illumination, the pupil dilates and, depending on the observer, there 

might be an image on the retina generated by the optical zone, another generated by the 

transition zone, and even another by the unoperated anterior cornea. As all of these zones 

have different refractive powers, a defocused image forms with respect to that provided by 

the central optic zone of the cornea, which has been emmetropized. If the object presents 

high luminance, haloes may become perceptible to the observer. 

 

With the presence of these haloes, the discrimination of objects near the light source 

or to the stimulus declines. That is, a subject who sees haloes around a central source may 

 
 
  

    Photographs: José J. Castro 
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have difficulties in discriminating peripheral lights. This aspect is critical, for example, in 

night driving, where a low discrimination could trigger a traffic accident.  

 

The purpose of the Halo v1.0 software is to provide a simple way, under certain 

experimental conditions, to quantify this discrimination loss in subjects, especially in those 

that have been subjected to different emmetropization techniques (cataract and refractive 

surgery, especially LASIK), although it has also been used positively in cases of keratitis and 

age-related macular degeneration (ARMD). In addition, the software enables a study of the 

effects of the experimental conditions in the discrimination capacity of the subject and the 

post-surgical temporal evolution of this discrimination.  

 

 Prior to the administration of the test, it is advisable to fix the observer’s viewing 

posture by a chin rest and forehead support, at an appropriate distance from the monitor, i.e. 

taking into account the angular size of the stimuli. The combination of the distance from the 

test monitor and the spatial parameters controlled with the software will enable the desired 

configuration to be made.  

 

 In the test, the subject is shown a central luminous stimulus over a dark background 

and, progressively, peripheral stimuli are shown around the central one, at different positions 

and at different distances from the central one. The task of the subject is to press a button on 

the mouse each time a peripheral stimulus is perceived. 

 

 When the test ends, the Halo v1.0 software allows the results not only to be exported 

to a text document, but also to be visualized and stored in graphic form in an image format.  

 

 Before the software functions and manner to execute the test are described, it should 

be clarified that the term “halometer” is used for the ensemble made up of Halo v1.0 

software, installed previously in a computer, plus a chin rest and forehead support in order to 

fix the position of the observer, in addition to the computer itself with a calibrated monitor 

that enables the test to be visualized.   
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 One of the first halometers was designed by the English ophthalmologist Robert H. 

Elliot in 1924.  In the same year, an article was published with the description of the device 

in the British Medical Journal (Elliot, 1924). 
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2.1. System requirements. 

 

- The software works with Windows 2000, Windows NT, Windows Xp or Windows Vista. 

- Minimum processor Pentium 166 MHz or compatible processor. 

- 256MB of RAM memory. 

- At least 14MB space available in the hard disk. 

- Graphics card of at least 4MB video memory. 

- Monitor with a minimum resolution of VGA 800x600 pixels with at least 8 color bits. 

 

 

2.2. Download and Installation of Halo v1.0 software. 

 

 Halo v1.0 software was created and developed by the Laboratory of Vision Sciences 

and Applications of the University of Granada (Granada, Spain). Halo v1.0 can be 

downloaded from the webpage http://www.ugr.es/~labvisgr/, as a compressed file. Once the 

file is downloaded to the computer where the software is to be installed, follow these 

instructions: 

 

- Decompress the file “Halov1.0_Software” and execute “Halo_Setup.exe”. 

- A window will appear to select the language. Due to the configuration of the 

operating system, this window will appear in the language configured in this 

system (Fig. 2.1). In this case, select “English” and click on “OK”. 

 

 
 

Figure 2.1. Window to choose the language of the installation. 

2.  T U T O R I A L .  
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- The steps of the installation process are followed as they appear in the different 

windows.  Then, click on “Next” and “OK” until the process ends.  Figures 2.2, 

2.3, 2.4, and 2.5 show the different windows that appear during the process.  If 

Windows Vista is being used, and problems arise during the installation, try 

installing the updates of the operating system (Start > Windows Update). 

 

 
Figure 2.2. Window to prepare for the installation of Halo v1.0. 

 

 
Figure 2.3. Choice of destination folder. 
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Figure 2.4. Windows that will be appearing during the installation process: a) start of the 

installation; b) state of the process; c) end of the installation. 

a) 

b) 

c) 
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- When the installation is finished, a direct access will be created on the desktop: “Halo 

v1.0”. 

 

 

2.3. First steps with Halo v1.0. 

 

2.3.1. Introduction. 

 

 For access to the software, double click on the direct access of the desktop or follow:  

Start > All Programs > Halometer > Halo v1.0 > Halo v1.0.  On opening the program, the 

main window of the software will appear (Fig. 2.5). 

 

 
 

Figure 2.5.  The main window of Halo v1.0 software. The parameters are shown by default. 
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 Halo v1.0 presents a structure similar to that of any other software (File, Options, 

Tools, Help), as can be appreciated in Figure 2.5. Below, each of the possible options of the 

software are detailed. 

 

2.3.2. File. 

 

 
 

Figure 2.6. Options displayed in “File”. 

 

Click on “File” to show the following options: 

 

a) Save Results: open the dialog box to save the text file with the test results. This action 

must be made after finishing the test and before closing the software. 

b) Save Graph: this saves the graphics of the results in which both the peripheral stimuli 

detected as well as those not detected are showed (Fig. 2.21). 

c) Exit: close and leave the software. 

 

2.3.3. Options. 

 

 
 

Figure 2.7. Options displayed in “Actions”. 
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In this case, the options when clicking on “Options” are: 

 

a) Show last Statistics: the results of the last test made are shown, so long as the 

software was not closed after the last test. All the parameters configured for the test 

(temporal, spatial, color, weight, etc.) as well as the disturbance indices are visualized 

(point 2.5.1). 

b) Show last Results: the graph of the results of the last test is shown. 

c) Run test: start the test. The first step is the darkness-adaptation time (luminance of the 

monitor). 

d) Default Parameters: this reestablishes all the parameters that the software has 

configured by default (these parameters appear in Fig. 2.5). A window will appear to 

confirm the new configuration (Fig. 2.8). 

 

 
Figure 2.8. Window to confirm the establishment of the default parameters. 

 

2.3.4. Tools. 

 

 Click on “Tools” for the following options: 
 

 
 

Figure 2.9. Options displayed in “Tools”. 
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a) Pixel-millimeter Converter: the converter of pixels to millimeters is a tool that 

provides the equivalence between millimeters and pixels of the monitor on which the 

test is to be presented. When this tool is selected, the window shown in Figure 2.10 

appears. The software automatically calculates the size of the monitor, as its 

resolution is known (this information is obtained from the graphics card used). With 

this, in the upper part of the window, the option “Pixel-millimeter calculator” 

appears. For this, introduce a value in the box of the pixels and click on “Calculate”.  

The minimum value permitted to calculate is 100 pixels (it would be trivial to 

calculate the size of one pixel in millimeters), while the minimum increase is 1 pixel.  

  

 
 

Figure 2.10. Window “Pixel-millimeter converter”. 

 

However, it is advisable to calculate the pixel-mm equivalence manually due to 

possible conflicts between the software and the graphics card, which would result in 

an inaccurate equivalence. For this, select the box “Manual”. Just afterwards the 

window shown in Figure 2.11 will appear. Introduce both the height and width of the 

monitor (in mm) and click on “OK”.  
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Figure 2.11. Window to configure the size of the monitor.  

 

 

b) Set Profile: this tool enables one of the 5 predetermined profiles of the software to be 

selected. These profiles show typical configurations that have been used in different 

tests with subjects. The configuration of parameters for each of the profiles is shown 

in Table 2.1. It should be taken into account that a color configuration has been 

chosen according to the sensitivity of the subject and, basically, this configuration 

permits the selection of a luminance determined for the stimuli. Other tests can be run 

taking into account the discrimination of different colors, but this is not the case. 

 

 
 

 

Figure 2.12. Window that permits the selection of one of the profiles configured. 
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 Profile 1 Profile 2 Profile 3 Profile 4 Profile 5

Main Stimulus Radius (pixels) 20 20 20 20 20 

Peripheral Stimulus Radius (pixels) 2 3 4 5 6 

Maximum Radius (pixels) 50 60 65 85 95 

Number of stimuli per semiaxis 3 3 3 3 3 

Number of semiaxes 12 12 12 12 12 

Darkness (s) 180 180 180 180 180 

Main Stimulus (s) 60 60 60 60 60 

Exposure (s) 1 

Refresh - Initial (s) 2 

Refresh -  Final (s) 3 

Show main stimulus   

Weight 1 

Main Stimulus Color White 

Peripheral Stimulus Color Gray 

 

                                 
   

                    White (main stimulus)                                           Gray (peripheral stimulus) 
 

 

Table 2.1. Configuration of the parameters of the test for each profile. Beneath the table the color 

configurations are shown in the standard palette. 

 

 

As can be seen, the only parameters that change from one profile to another are the 

radius of the peripheral stimulus and the maximum radius. In fact, Profile 1 would be 

appropriate for a subject with good discrimination of the peripheral stimuli, Profile 2 

for a subject with less discrimination and some influence of haloes, and so on to 
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Profile 5, which corresponds to a subject having seriously deficient peripheral stimuli 

and a strong influence of haloes. However, these configurations of parameters are 

only an example and thus can be changed to have different configurations, taking into 

account the discrimination of the observers to whom the test is directed. For 

orientation, some typical configurations are shown, these used in tests for different 

cases (ARMD, keratitis, after refractive surgery, etc.) in Section 3 (Configurations 

used in experiments). 

 

c) Language: this permits the selection of the language (Spanish or English). To change 

the language, for example, from English to Spanish, follow Tools > Language > 

Spanish; if from Spanish to English, Herramientas > Idiomas > Inglés. A window 

will appear stating that the software must be restarted for the change to be effective 

(Fig. 2.13).  

 

 
 

 

 
 

 

Figure 2.13. Confirmation (in English and in Spanish) to close the application 

for the change of language to be effective.   
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2.3.5. Help. 

 

 
 

Figure 2.14. Option displayed in “Help”. 

  

 

 Follow Help > About Halo v1.0 and a window will appear with all the information on 

the Halo v1.0 software (Fig. 2.15): function of the application, data of the copyright, contact, 

logo, etc. 

 

 
 

Figure 2.15. Information on Halo v1.0 software shown in “Help > About Halo v1.0”. 
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2.4. Description of the functions of the Halo v.1.0 software. 

 

 In addition to the tool bar described in the previous section, Halo v1.0 presents a 

series of parameters that can be controlled by assigning values (the units of measurement are 

indicated), or by simple selection. Below, the parameters that appear in Halo v1.0 are defined 

and detailed. 

 

2.4.1. Spatial Parameters. 

  

 The spatial parameters are represented graphically in Figure 2.16. 

 

 
 

Figure 2.16. Graphic scheme of the spatial parameters used in the test.  

Main 
Stimulus 

Peripheral Stimuli  

Number of stimuli per semiaxis 
(in this case, 3) 

Dark Background 
(null or almost null luminance) 

rp 

rmax 

rc 

rc + rp

rmax: Maximum radius 
rc : Main Stimulus Radius 
rp : Peripheral Stimulus Radius 
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 The spatial parameters used in the test are measured in pixels, although, as already 

seen, there is an option in the software that allows the calculation of the equivalence between 

pixels and millimeters (Pixel-millimeter converter). Below, the different parameters are 

detailed.  

 

 Main Stimulus Radius: this is the radius, measured in pixels, of the central or main 

stimulus. 

 

 Peripheral Stimulus Radius: this is the radius, measured in pixels, of the 

peripheral stimuli, the latter being the stimuli presented to the observer around the 

main stimulus.  

 

 Maximum Radius: this is the distance, in pixels, measured from the center of the 

main stimulus to the center of the farthest peripheral stimulus. 

 

 Number of Stimuli per semiaxis: the number of peripheral stimuli distributed in 

each semiaxis. 

 

 Number of semiaxes: this is the number of semiaxes along which the peripheral 

stimuli are presented. 

 

 Show Radii. Clicking this option shows a general graph giving information on the 

representation of the peripheral stimuli with respect to the semiaxes and main 

stimulus (Fig. 2.17, corresponding to the default parameters). It also provides the 

distance from the center of the main stimulus to the center of each of the 

peripheral stimuli along the semiaxis. 

 

 For values to be assigned to the spatial parameters, it suffices to introduce directly the 

desired numerical value in the box situated just to the right of the parameter in question. 

Also, values can be assigned by clicking on the buttons “up” and “down” of the same box 

until reaching the desired value. The precision is ±1 pixel. 
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Figure 2.17. Window specifying the distances of each peripheral stimulus to the 

center of the main stimulus, i.e. the different Ri. 

 

2.4.2. Temporal Parameters. 

  

 The temporal parameters of the test are measured in seconds, and numerical values 

can be introduced with a precision of ±0.1 s, either by typing in the value (with coma or dot) 

or else by using the buttons “up” and “down” that appear in the box. 

 

 Darkness: time from the start of the test until the central stimulus appears for the 

first time. It is the time dedicated to darkness adaptation (luminance of the 

monitor background) by the observer. An adaptation time of 3 minutes might be 

adequate. 

 

 Main Stimulus: indicates the time from the first appearance of the central stimulus 

until the first appearance of the peripheral stimulus. It is the adaptation time to the 
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main stimulus once the subject is adapted to darkness. In the event that the subject 

indicates that the luminance is very high, another luminance is chosen and the 

adaptation process begins again. 

 

 Exposure: time of exposure to the peripheral stimulus, that is, it is the time that is 

shown on the monitor by each peripheral stimulus. A typical time used in similar 

experiments is 1.25 s. 

 

 Refresh: time between peripheral stimuli (from the appearance of a peripheral 

stimulus to the appearance of the next one). For this time, an upper and lower 

limit is set by introducing the values in the corresponding boxes. This time is a 

random value of the interval established, thus minimizing the effect of learning of 

the subject and avoiding false positives in the detection of the stimuli. A typical 

example would be between 2 and 3 seconds.  

 

 Show main stimulus: although it is not properly a temporal parameter, it is the 

option of showing or not the central stimulus between presentations of peripheral 

stimuli. It is advisable to select this option, as showing the central stimulus helps 

maintain the fixation of the observer.  

 

2.4.3. Color configuration. 

 

 In this section, the color can be configured both for the central stimulus as well as for 

the peripheral ones. As the Halo test is intended to evaluate the disturbances in night vision, 

especially in the presence of intense light sources, which can prompt haloes in the vision of 

the observers, it is advisable to use a high 

luminance for the central stimulus (the most 

appropriate color would be white) and a lower 

luminance for the peripheral stimuli. This 

configuration approaches real situations, in 

which, the effect of the halo from an intense 

luminous stimulus causes nearby objects or 

stimuli not to be perceived. 

 
 

 

Figure 2.18. Option to configure the 

color of the stimuli. 
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 A color can be selected by clicking on the box of the corresponding stimulus (main or 

peripheral) and a standard palette of colors appears (Fig. 2.19a). To personalize the color, 

click on “More colors…” and a standard window will appear to configure a personalized 

form of the color (Fig. 2.19b). 

 

 
Figure 2.19. Color configuration of the stimuli: a) standard color palette and b) window to 

configure the personalized color of the stimuli. 

 

 

2.4.4. Phychophysical Procedure. 

 

 This option shows a single parameter, “Weight”, which indicates the number of times 

that each stimulus was presented. For example, let us consider a test that is to be 

administered with 5 peripheral stimuli per semiaxis, with a total of 12 semiaxes. If the 

numerical value 2 is introduced for weight, each of the 60 total peripheral stimuli is 

presented to the observer twice.  In all cases, the peripheral stimuli are shown randomly both 

in space as well as in time. 

 

  

a) 

b)
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2.4.5. Run test. 

  

 Once all the parameters are established, the test 

can be executed by clicking on the button “Run test” 

(Fig. 2.20) situated in the lower right-hand part of the 

main window of the software. Another way of executing 

the test is by following Options > Run Test. Previously, 

the position of the observer is fixed with the chin rest and 

the forehead support. When the test ends, the graph of the results is shown. To exit, press the 

key “Esc” of the keyboard and save the results (point 2.5.2).  

 

 

2.5. Test results. 

 

2.5.1. Calculation of the Disturbance Index. 

 

 The discrimination of the peripheral stimuli in the presence of haloes around a central 

stimulus (or night-vision disturbances) is evaluated by a parameter called the Disturbance 

Index.  

 

 Once the weight p and the number of semi-axes are assigned, this index could be 

calculated in different ways: as the quotient of the total area of the peripheral stimuli not 

detected by the subject, divided by the total area of the stimuli presented to the subject 

(quadratic disturbance index). It’s also calculated taking into account the distance from the 

peripheral stimuli not detected by the subject to the main-stimulus center (this criterion is 

used by the Halo v1.0 software; see formulae in table 2.2).  

 

 The disturbance index takes values of between 0 and 1, in such as way that the greater 

the index, the lower the discrimination capacity, and therefore the subject has more 

difficulties in detecting the peripheral stimuli near the central stimulus, indicating a greater 

influence of haloes or night-vision disturbances.  

 

 
 Figure 2.20. “Run test” button. 
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 However, the disturbance index can be expressed in two ways: linear and quadratic.  

Table 2.2 provides the formulae for their calculation. The Halo v1.0 software gives both 

indexes (linear and quadratic). 

 

Disturbance Index Formula 

 

Linear Disturbance Index, lρ  

 ∑

∑

=

== N

i
i
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i
ii

l
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1ρ  

 

Quadratic Disturbance Index, qρ  
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2

ρ  

Variable Description 

ri Distance from the center of the central stimulus to the center of 

the i-peripheral stimulus (in pixels). 

p Total weight (number of times that each stimulus i is shown). 

pi Number of times over the total weight (pi ≤ p) that the i-peripheral 

stimulus is not detected by the subject. 

 

Table 2.2. Formulae for the calculation of the two types of disturbance indexes. Also, the 

variables used are described. 

 

 Although the Disturbance Index will be used, another way to quantify the 

discrimination capacity to the peripheral stimuli would be to define the Discrimination Index, 

linear (δl = 1 – ρl) or quadratic (δq = 1 – ρq). Thus, the greater the discrimination index, the 

greater the capacity of the observer to discriminate or detect the peripheral stimuli and 

therefore the lower the influence of the perceived haloes. This index varies from 1 to 0, so 

that a discrimination index of δ = 1 would indicate the best discrimination possible in the 

test, and δ = 0 would indicate the worst discrimination possible.  
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2.5.2. Finalization of the test. Save results.  

 

 After the subject is presented p times (weight) with each of the total peripheral 

stimuli, a graph appears on the screen to show the results. In the center appears the main 

stimulus and around it a number or an X in each of the positions of the different peripheral 

stimuli presented (Fig. 2.21): 

 

 The number will appear in green to indicate the number of times that the observer has 

detected the stimulus and therefore has pressed the button of the mouse. The highest 

value that could appear would of course be the weight selected before the test. 

 

 An X will appear when the observer fails to detect any stimulus of the p times that it 

is shown.  

 

 
 

 

Figure 2.21. Enlargement of the zone of interest of the graph showing the test results. 
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 To exit the monitoring of the graph, press the button “Esc” (Escape) of the keyboard.  

Just afterwards, a window will appear with “Test results”, permitting the results to be saved 

(Fig. 2.22). For this, first introduce the number of the observer or a reference number, to 

identify it. Afterwards click on the button <  > in order to select the directory where the 

file of the text results is to be saved. A standard window “Save as…” will appear showing 

the directory chosen so that the file can be named. It is important that, on naming the file, the 

extension (.txt) is kept. Thus, if the file is called “Test_4”, it is necessary to type in 

“Test_4.txt”. 

 

 To save the graph in image format (.tiff), after the test is finished, follow File > Save 

Graph.  A standard window will appear “Save as…”, permitting the image to be saved in the 

folder selected and assign it a name. Figure 2.21 shows, for a given test, the enlarged zone of 

interest in the graph of the results.  

 

 
 

Figure 2.22. Window that appears after finishing the test used to save the results. 

 

 

 The results must be saved before closing the software or else the data is lost. The file 

with the results and statistics are saved in English for both language configurations of the 

software (Spanish and English), thereby maintaining a single criterion with respect to the 

results. 

 

2.5.3. Visualization of the results.  

 

 The results can be visualized in two ways:  
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- Before closing the software, follow Options > Show last Statistics, if the desire is to 

visualize the data; or Options > Show last Results, if the desire is to see the graph of 

the results.  

 

- Open the text file or the image in the format “.tiff”, both saved in the directory 

chosen. 

 

 
 

Figure 2.23. Example of a text file with the results of a test. 
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 Figure 2.23 shows the text file with the data and statistics: date and hour of 

administering the test, name of subject or patient, spatial and temporal parameters of the test 

performed, color configuration, weight, and, lastly, the statistical results (linear and quadratic 

disturbance index). 

 

 

2.6. Desinstalación del software Halo v1.0. 

 

 Halo v1.0 software can be uninstalled like other similar softwares. To uninstall the 

software access Control Panel > Programs (Uninstall programs) and then select Halo v1.0. 

Another way to uninstall it is following Start > All Programs > Halometer > Halo v1.0 > 

Uninstall Halo v1.0. 

 

 
 

Figure 2.24. Window to confirm the uninstallation process. 

 

 
 

Figure 2.25. Window preparing for the uninstallation of Halo v1.0. 

. 
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 Below appear some configurations of parameters used in different experiments with 

subjects that present ARMD or keratitis, or who have been subjected to some type of surgery 

(refractive or cataract). For this, Table 2.1 is used, shown under point 2.3.4.  

 

 Profile 1 Profile 2 Profile 3 Profile 4 Profile 5

Main Stimulus Radius (pixels) 20 20 20 20 20 

Peripheral Stimulus Radius (pixels) 2 3 4 5 6 

Maximum Radius (pixels) 50 60 65 85 95 

Stimuli per semiaxis 3 3 3 3 3 

Number of semiaxes 12 12 12 12 12 

Darkness (s) 180 180 180 180 180 

Main Stimulus (s) 60 60 60 60 60 

Exposure (s) 1 

Refresh - Initial (s) 2 

Refresh -  Final (s) 3 

Show main stimulus  

Weight  1 

Main Stimulus Color White 

Peripheral Stimulus Color Gray 

 

 

a) Subjects with ARMD. The profiles used for the tests were profiles 2, 3, 4, and 5, in 

which maximum radii of 60, 65, 85, and 95 pixels were used, respectively, although 

the most commonly used were the two first ones. Four stimuli per semiaxis were used 

instead of 3. For all the cases, a radius of 20 pixels was chosen for the central 

stimulus.  

 

 

3.  C O N F I G U R A T I O N S    U S E D   I N 

    E X P E R I M E N T S .
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b) Subjects with keratitis. This case is similar to the foregoing one, the only difference 

being that the maximum radii of 50 or 60 pixels were most frequently used. 

 

c) Subjects operated on with LASIK. The most appropriate profile in this case was 

profile 1. 

 

d) Subjects operated on for cataracts. Depending on the cataract of the subject and the 

result of the surgery, radii were used for the peripheral stimuli of 2, 3, or 4 pixels. 

 

 These profiles are only for reference, so that other configurations can be used for 

accurate quantification of haloes perceived by the observer. In any case, the ideal situation 

would be to start with the radius of the smallest peripheral stimulus in order to confirm 

whether it is detected or not by the subject. If not, the radius of the stimulus is increased until 

it is detected, and this radius is the one used to administer the definitive test. 
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